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See Also

Using the Chart Tool

g

The Chart tool displays state data in an x-y plot format. Use the x-y
plots to quickly identify valid data in the form of visual patterns.

e  “Analog to Digital Converter Testing” on page 12

e  “Zooming in on Chart Data - Scaling” on page 9

e “Finding a Pattern” on page 11

e “Loading and Saving Chart Configurations” on page 16

e “Printing the Chart Window” on page 15

Working with Markers (see the Markers help volume)
“Seeing Measurement Results - Popup on Run” on page 23
“Choosing which Data to Plot” on page 13

“Selecting the Numeric Base” on page 17

“Changing Plot Type and Color” on page 8

“Turning Tabs On or Off in the Display Window” on page 24

Using the Analysis Tab (see the HP 16600A/16700A Logic Analysis
System help volume)

Using the Mixed Signal Tab (see the HP 16600A/16700A Logic Analysis
System help volume)

Main System Help (see the HP 16600A/16700A Logic Analysis System
help volume)

Glossary of Terms (see page 27)
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Chapter 1: Using the Chart Tool
Changing Plot Type and Color

Changing Plot Type and Color

To Change Plot Type 1. From the tool’s menu bar, click Options, then select Plot Type.

2. Select the desired plot type.

Dot Dot

To Change Label Color 1. From the tool’s menu bar, click Options, then select Color.

2. Select the desired label color, then click Apply.
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Typing in Axis Values

Quick Zoom

See Also

Chapter 1: Using the Chart Tool
Zooming in on Chart Data - Scaling

Zooming in on Chart Data - Scaling

There are two ways to scale the chart and zoom in on a desired view.
One is to type in minimum and maximum values for the chart axis, the
other is to zoom.

1. Click on the axis value field.
2. Backspace or delete the current numbers.
3. Type the new axis value, then click Apply.
¥ min 0000
¥ max [ oorr

Point to the desired top-left corner of the new viewing area. Press and
hold the left mouse button, then drag the dashed box to the desired
lower-right corner.

“Returning Chart View to Full Scale” on page 9

“Returning to Previous Zoom View - Undo” on page 10

Returning Chart View to Full Scale

After zooming in on chart data or scaling the view, you may want to
return to a full-scale view. To return to a full-scale view:

e Right-click anywhere in the viewing area, and select the Full Scale option
from the list.




Chapter 1: Using the Chart Tool
Zooming in on Chart Data - Scaling

Returning to Previous Zoom View - Undo

After several zoom operations on chart data, you may want to return to
a previous zoom view. To return to previous zoom views:

e Right-click anywhere in the viewing area, and select Undo scaling from
the list.
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Chapter 1: Using the Chart Tool
Finding a Pattern

Finding a Pattern

To find a data pattern or value in the chart data, place a marker (see
the Markers help volume) in the data.

If you have placed multiple markers in the data, you can view the
interval (see the Markers help volume) between the markers.

“Reading the X-Y Pointer Position” on page 14
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Chapter 1: Using the Chart Tool
Analog to Digital Converter Testing

Analog to Digital Converter Testing

A basic tool configuration for this test is the Chart tool connected to a
state analyzer, with data bits O through 7 of the A to D convertor
connected to input channels 0 through 7 of the analyzer respectively.
Also, the A to D clock-out is connected to the clock input of the
analyzer pod.

1. In the Chart tool, select the label (see page 13) assigned to the incoming
signals from the A to D convertor.

2. Change the plot type (see page 8) to Line.
3. Repetitive run (see page 20) the analyzer.

4. Scale the chart axis (see page 9) so the maximum peak-to-peak amplitude
conversion of the A to D is plotted full scale.

Ideal results are that as the amplitude of the analog input signal to the
A to D is increased, the output (viewed in Chart) will i not be clipped
before the full scale specification of the A to D convertor is reached.

Chart
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Chapter 1: Using the Chart Tool
Choosing which Data to Plot

Choosing which Data to Plot

Data is plotted by label, and the available labels are the ones that you
assigned in the Format window of the instrument tool being used.
To plot data assigned to a label, simply select the desired label from the

label list.
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Chapter 1: Using the Chart Tool
Reading the X-Y Pointer Position

Reading the X-Y Pointer Position

You can quickly read the value of any point on the chart by pointing the
mouse cursor to the desired place on the chart, then by reading the X-
Y pointer position.

® = dl6 ¥ o= 004A

14



NOTE:
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Chapter 1: Using the Chart Tool
Printing the Chart Window

Printing the Chart Window

The print windows operation enables you to print just the Chart tool
window. Use this operation if you want a hardcopy or electronic record
of configurations and data currently displayed in the viewing area of
the Chart window.

Only the currently displayed viewing area of the Chart window is printed. If
any data or configuration fields appear offscreen, scroll the desired data or
configuration fields into the window’s viewing area before printing.

1. Optional - configure the Print Option (see the HP 16600A/16700A Logic
Analysis System help volume) if desired.
Print Options include print destination, file format type, filename
autoincrement, and color/b&w; pixel mapping.

2. Inthe Chart tool menu bar, click Fzle, then select Print This Window. The
print output will be as configured in the Print Options in step 1.

Print Option (see the HP 16600A/16700A Logic Analysis System help
volume)

Printer Setup (see the HP 16600A/16700A Logic Analysis System help
volume)

“Including Comments on Screen Prints” on page 25

15



NOTE:

Chapter 1: Using the Chart Tool
Loading and Saving Chart Configurations

Loading and Saving Chart Configurations

Chart Tool settings can be saved to a configuration file along with the
tools connected to it, and loaded from a previously saved configuration
file.

e Loading Configuration Files (see the HP 16600A/16700A Logic Analysis
System help volume)

e Saving Configuration Files (see the HP 16600A/16700A Logic Analysis
System help volume)

The Load Configuration window can be accessed via File->Load
Configuration.
The Save Configuration window can be accessed via File->Save
Configuration.
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Chapter 1: Using the Chart Tool
Selecting the Numeric Base

Selecting the Numeric Base

Base Field

1. Click on the base field.

2. Select the desired base type, then click Apply.

17



Chapter 1: Using the Chart Tool
Run/Group Run Function

Run/Group Run Function

e Setting a tool for independent or Group Run (see page 19)
e Setting Single or Repetitive Run (see page 20)

e  “Checking Run Status” on page 20

Understanding Run/Run All/Group Run

The Run/Run All/Group Run buttons initiate data capture in the
instrument tools you have configured. When an instrument tool is
connected to analysis or display tools, any of the tools can initiate a
run. When two or more instrument tools are configured, you can run
them independently or as a group. Two or more instruments running as
a group is called an Intermodule measurement.

Use the Intermodule Window (see the HP 16600A/16700A Logic
Analysis System help volume) to coordinate the run function of
multiple instruments as a "Group Run". A common "Group Run"
configuration is to run the instrument tools at the same time. A more
advanced measurement is to configure one instrument to arm another
instrument, each with their own trigger conditions.

e Run appears in the setup dialog and icon menu of an instrument if it is not
part of an Intermodule measurement.

e Group Run appears in the setup dialog and icon menu of each tool if two or
more instruments are configured for an Intermodule measurement.

e Run All always appears in the System, Workspace and Run Status
windows, and initiates a run in all configured instruments, whether they
are run independently or are part of a Group Run.

Intermodule measurements are configured between individual
instruments. Arming between two machines that belong to one
analyzer is configured in the Arming Info... dialog found in the Trigger
window of the analyzer.

Understanding Stop/Stop_All/Cancel

e Stop will terminate an individual instrument measurement that is running.
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Chapter 1: Using the Chart Tool
Run/Group Run Function

(perhaps waiting for a trigger condition)

e Stop All, when selected from the Workspace, will terminate running
measurements from all instruments currently on the Workspace.

e (Cancel will terminate the processing of trace data from an instrument to an
analysis or display tool connected to its output.

See Also “Demand Driven Data” on page 21

Setting a tool for independent or Group Run

Use the Intermodule Window to change between Group Run and
independent Run.
e (lick the Intermodule icon in the System Window, OR

e Use Navigate->System->Intermodule

In the Intermodule window, move instruments between independent
Run and Group Run by clicking the icon and selecting the desired
arming source. All instruments in "Group Run" will run simultaneously.
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Chapter 1: Using the Chart Tool
Run/Group Run Function

Setting Single or Repetitive Run

A single measurement will stop after memory is full or a store
qualification is met. A repetitive measurement executes successive
Single measurements until Stop is selected.

When a single or repetitive measurement is stopped, only data that has
been captured to that point is available for viewing.

Select single or repetitive by right-clicking on the Run button in the
tool’s setup window.

| Run
4+ Single
Repetitive

If you have problems displaying trace data when running Repetitive
measurements, see “Demand Driven Data” on page 21.

Checking Run Status

The Run Status dialog provides status information about the currently
configured instruments, and the status of the run with respect to the
trigger specification.

To access the Run Status dialog:
e The Run Status icon in the System Window, OR

e Navigate->System->Run Status

20



Chapter 1: Using the Chart Tool
Run/Group Run Function

[run pil |
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Clear Messazes Close E

Demand Driven Data

When an analyzer measurement occurs, acquisition memory is filled
with data that is then transferred to the display memory of the analysis
or display tools you are using, as needed by those tools. In normal use,
this demand driven data approach saves time by not transferring
unnecessary data.

Since acquisition memory is cleared at the beginning of a
measurement, stopping a run may create a discrepancy between
acquisition memory and the memory buffer of connected tools. Without
a complete trace of acquisition memory, the display memory will
appear to have 'holes’ in it which appear as filtered data.

This situation will occur in these cases:

e [f you stop a repetitive measurement after analyzer data has been cleared
and before the measurement is complete.

e [f atrigger is not found by the analyzer and the run must be stopped to
regain control.

To make sure all of the data in a repetitive run is available for viewing:
¢ In the workspace, attach a Filter tool to the output of the analyzer.
e In the Filter, select "Pass Matching Data"

e In the filter terms, assure the default pattern of all "Don't Cares" (Xs).
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Chapter 1: Using the Chart Tool
Run/Group Run Function

This configuration will always transfer all data from acquisition
memory. While this configuration will increase the time of each run, it
will guarantee that repetitive run data is available regardless of when it
is stopped.
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Chapter 1: Using the Chart Tool
Seeing Measurement Results - Popup on Run

Seeing Measurement Results - Popup on Run

By default, measurement results do not pop up automatically when an
analyzer completes its run. If you wish to have a display of
measurement results pop up when a run is completed, do the following:

e (lick Options in the menu bar and select Popup on Run and On.
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Chapter 1: Using the Chart Tool
Turning Tabs On or Off in the Display Window

Turning Tabs On or Off in the Display Window

The tabs in the display window give you quick access and visual
reference to all the capabilities in the display window. You may wish to
turn the tabs off to simplify display content.

e (lick Options in the menu bar and select Tabs and On or Off.
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Chapter 1: Using the Chart Tool
Including Comments on Screen Prints

Including Comments on Screen Prints

When you have tabs turned on, you can also enter your own comments
on screen. This allows you to obtain a printed copy of your screen that
includes your comments.

e Turn tabs on, (see page 24) and under the Tabs On option, select Stack
comments.

e Enter the text you wish to see in the print of your display.
Each print can include multiple comment lines. If you need more than the
default two comment lines, resize the comment text window using the
sash.
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Including Comments on Screen Prints
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Glossary

absolute Denotes the time period
or count of states between a captured
state and the trigger state. An
absolute count of -10 indicates the
state was captured ten states before
the trigger state was captured.

acquisition Denotes one complete
cycle of data gathering by a
measurement module. For example,
if you are using an analyzer with
128K memory depth, one complete
acquisition will capture and store
128K states in acquisition memory.

analysis probe A probe connected
to the target microprocessor. It
provides an interface between the
signals of the target microprocessor
and the inputs of the logic analyzer.
Also called a "preprocessor".

analyzer 1 In alogic analyzer with
two machines, refers to the machine
that is on by default. The default
name is Analyzer<N>, where N is
the slot letter.

analyzer 2 In a logic analyzer with
two machines, refers to the machine
that is off by default. The default
name is Analyzer<N2>, where N is
the slot letter.

arming An instrument tool must be
armed before it can search for its
trigger condition. Typically,

instruments are armed immediately
when Run or Group Run is selected.
You can set up one instrument to arm
another using the Imtermodule
Window. In these setups, the second
instrument cannot search for its
trigger condition until it receives the
arming signal from the first
instrument. In some analyzer
instruments, you can set up one
analyzer machine to arm the other
analyzer machine in the Trigger
Window.

asterisk (*) See edge terms,
glitch, and labels.

bits Bits represent the physical logic
analyzer channels. A bit is a channel
that has or can be assigned to a label.
A bit is also a position in a label.

card This refers to a single
instrument intended for use in the
HP 16600A-series or HP 16700A
mainframe. One card fills one slot in
the mainframe. A module may
comprise a single card or multiple
cards cabled together.

channel The entire signal path from
the probe tip, through the cable and
module, up to the label grouping.

click To click an item, position the
cursor over the item. Then quickly
press and release the left mouse
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Glossary

button.

clock channel A logic analyzer
channel that can be used to carry the
clock signal. When it is not needed
for clock signals, it can be used as a
data channel, except in the

HP 16517A.

context record A context record is
a small segment of analyzer memory
that stores an event of interest along
with the states that immediately
preceded it and the states that
immediately followed it.

context store If your analyzer can
perform context store
measurements, you will see a button
labeled Context Store under the
Trigger tab. Typical context store
measurements are used to capture
writes to a variable or calls to a
subroutine, along with the activity
preceding and following the events. A
context store measurement divides
analyzer memory into a series of
context records. If you have a 64K
analyzer memory and select a 16-
state context, the analyzer memory is
divided into 4K 16-state context
records. If you have a 64K analyzer
memory and select a 64-state
context, the analyzer memory will be
divided into 1K 64-state records.

count The count function records

periods of time or numbers of state
transactions between states stored in
memory. You can set up the analyzer
count function to count occurrences
of a selected event during the trace,
such as counting how many times a
variable is read between each of the
writes to the variable. The analyzer
can also be set up to count elapsed
time, such as counting the time spent
executing within a particular function
during a run of your target program.

cross triggering Using intermodule
capabilities to have measurement
modules trigger each other. For
example, you can have an external
instrument arm a logic analyzer,
which subsequently triggers an
oscilloscope when it finds the trigger
state.

data channel A channel that
carries data. Data channels cannot be
used to clock logic analyzers.

data field A data field in the pattern
generator is the data value associated
with a single label within a particular
data vector.

data set A data set is made up of all
labels and data stored in memory of
any single analyzer machine or
instrument tool. Multiple data sets
can be displayed together when
sourced into a single display tool. The
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Filter tool is used to pass on partial
data sets to analysis or display tools.

debug mode See monitor.

delay The delay function sets the
horizontal position of the waveform
on the screen for the oscilloscope and
timing analyzer. Delay time is
measured from the trigger point in
seconds or states.

demo mode An emulation control
session which is not connected to a
real target system. All windows can
be viewed, but the data displayed is
simulated. To start demo mode,
select Start User Session from the
Emulation Control Interface and
enter the demo name in the
Processor Probe LAN Name field.
Click Help in the Start User Session
window for details.

deskewing To cancel or nullify the
effects of differences between two
different internal delay paths for a
signal. Deskewing is normally done
by routing a single test signal to the
inputs of two different modules, then
adjusting the Intermodule Skew so
that both modules recognize the
signal at the same time.

don’t care For terms, a "don’t care"
means that the state of the signal
(high or low) is not relevant to the

measurement. The analyzer ignores
the state of this signal when
determining whether a match occurs
on an input label. "Don’t care" signals
are still sampled and their values can
be displayed with the rest of the data.
Don’t cares are represented by the X
character in numeric values and the
dot (.) in timing edge specifications.

dot (.) See edge terms, glitch,
labels, and don’t care.

double-click To double-click an
item, position the cursor over the
item, and then quickly press and
release the left mouse button twice.

drag and drop To drag and drop an
item, position the cursor over the
item, and then press and hold the left
mouse button. While holding the left
mouse button down, move the mouse
to drag the item to a new location.
When the item is positioned where
you want it, release the mouse
button.

edge mode In an oscilloscope, this
is the trigger mode that causes a
trigger based on a single channel
edge, either rising or falling.

edge terms Logic analyzer trigger
resources that allow detection of
transitions on a signal. An edge term
can be set to detect a rising edge,
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falling edge, or either edge. Some
logic analyzers can also detect no
edge or a glitch on an input signal.
Edges are specified by selecting
arrows. The dot (.) ignores the bit.
The asterisk (¥) specifies a glitch on
the bit.

emulation module A module
within the logic analysis system
mainframe that provides an
emulation connection to the debug
port of a microprocessor. An E5901A
emulation module is used with a
target interface module (TIM) or an
analysis probe. An E5901B emulation
module is used with an E5900A
emulation probe.

emulation probe The stand-alone
equivalent of an emulation module.
Most of the tasks which can be
performed using an emulation
module can also be performed using
an emulation probe connected to
your logic analysis system via a LAN.

emulator An emulation module or
an emulation probe.

Ethernet address See link-level
address.

events Events are the things you
are looking for in your target system.
In the logic analyzer interface, they
take a single line. Examples of events

are Labell = XX and Timer 1 > 400
ns.

filter expression The filter
expression is the logical OR
combination of all of the filter terms.
States in your data that match the
filter expression can be filtered out or
passed through the Pattern Filter.

filter term A variable that you
define in order to specify which
states to filter out or pass through.
Filter terms are logically OR’ed
together to create the filter
expression.

Format The selections under the
logic analyzer Format tab tell the
logic analyzer what data you want to
collect, such as which channels
represent buses (labels) and what
logic threshold your signals use.

frame The HP 16600A-series or
HP 16700A logic analysis system
mainframe. See also logic analysis
system.

gateway address An IP address
entered in integer dot notation. The
default gateway address is 0.0.0.0,
which allows all connections on the
local network or subnet. If
connections are to be made across
networks or subnets, this address
must be set to the address of the
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gateway machine.

glitch A glitch occurs when two or
more transitions cross the logic
threshold between consecutive
timing analyzer samples. You can
specify glitch detection by choosing
the asterisk (*) for edge terms under
the timing analyzer Trigger tab.

grouped event A grouped event is
a list of events that you have
grouped, and optionally named. It can
be reused in other trigger sequence
levels. Only available in HP 16715A,
16716A, and 16717A logic analyzers.

held value A value that is held until
the next sample. A held value can
exist in multiple data sets.

immediate mode In an
oscilloscope, the trigger mode that
does not require a specific trigger
condition such as an edge or a
pattern. Use immediate mode when
the oscilloscope is armed by another
instrument.

interconnect cable Short name for
module/probe interconnect cable.

intermodule Intermodule is a term
used when multiple instrument tools
are connected together for the
purpose of one instrument arming
another. In such a configuration, an

arming tree is developed and the
group run function is designated to
start all instrument tools. Multiple
instrument configurations are done in
the Intermodule window.

intermodule bus The intermodule
bus (IMB) is a bus in the frame that
allows the measurement modules to
communicate with each other. Using
the IMB, you can set up one
instrument to arm another. Data
acquired by instruments using the
IMB is time-correlated.

internet address Also called
Internet Protocol address or IP
address. A 32-bit network address. It
is usually represented as decimal
numbers separated by periods; for
example, 192.35.12.6. Ask your LAN
administrator if you need an internet
address.

labels Labels are used to group and
identify logic analyzer channels. A
label consists of a name and an
associated bit or group of bits. Labels
are created in the Format tab.

line numbers A line number (Line
#s) is a special use of symbols. Line
numbers represent lines in your
source file, typically lines that have
no unique symbols defined to
represent them.
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link-level address Also referred to
as the Ethernet address, this is the
unique address of the LAN interface.
This value is set at the factory and
cannot be changed. The link-level
address of a particular piece of
equipment is often printed on a label
above the LAN connector. An
example of a link-level address in
hexadecimal: 0800090012AB.

local session A local session is
when you run the logic analysis
system using the local display
connected to the product hardware.

logic analysis system The

HP 16600A-series or HP 16700A
mainframe, and all tools designed to
work with it. Usually used to mean
the specific system and tools you are
working with right now.

machine Some logic analyzers allow
you to set up two measurements at
the same time. Each measurement is
handled by a different machine. This
is represented in the Workspace
window by two icons, differentiated
by a I and a € in the upper right-hand
corner of the icon. Logic analyzer
resources such as pods and trigger
terms cannot be shared by the
machines.

markers Markers are the green and
yellow lines in the display that are

labeled &, 0, G1, and G2. Use them to
measure time intervals or sample
intervals. Markers are assigned to
patterns in order to find patterns or
track sequences of states in the data.
The x and o markers are local to the
immediate display, while G1 and G2
are global between time correlated
displays.

master card In a module, the
master card controls the data
acquisition or output. The logic
analysis system references the
module by the slot in which the
master card is plugged. For example,
a b-card HP 16555D would be
referred to as Slot C: machine
because the master card is in slot C of
the mainframe. The other cards of
the module are called expansion
cards.

menu bar The menu bar is located
at the top of all windows. Use it to
select File operations, tool or system
Options, and tool or system level
Help.

message bar The message bar
displays mouse button functions for
the window area or field directly
beneath the mouse cursor. Use the
mouse and message bar together to
prompt yourself to functions and
shortcuts.

32



Glossary

module An instrument that uses a
single timebase in its operation.
Modules can have from one to five
cards functioning as a single
instrument. When a module has more
than one card, system window will
show the instrument icon in the slot
of the master card.

module/probe interconnect cable

The module/probe interconnect cable
connects an E5901B emulation
module to an E5900B emulation
probe. It provides power and a serial
connection. A LAN connection is also
required to use the emulation probe.

monitor When using the Emulation
Control Interface, running the
monitor means the processor is in
debug mode (that is, executing the
debug exception) instead of
executing the user program.

panning The action of moving the
waveform along the timebase by
varying the delay value in the Delay
field. This action allows you to
control the portion of acquisition
memory that will be displayed on the
screen.

pattern mode In an oscilloscope,
the trigger mode that allows you to
set the oscilloscope to trigger on a
specified combination of input signal

levels.

pattern terms Logic analyzer
resources that represent single states
to be found on labeled sets of bits; for
example, an address on the address
bus or a status on the status lines.

period (.) See edge terms, glitch,
labels, and don’t care.

pod See pod pair

pod pair A group of two pods
containing 16 channels each, used to
physically connect data and clock
signals from the unit under test to the
analyzer. Pods are assigned by pairs
in the analyzer interface. The number
of pod pairs avalaible is determined
by the channel width of the
instrument.

point To point to an item, move the
mouse cursor over the item.

preprocessor See analysis probe.

primary branch The primary
branch is indicated in the Trigger
sequence step dialog box as either
the Then find or Trigger on
selection. The destination of the
primary branch is always the next
state in the sequence, except for the
HP 16517A. The primary branch has
an optional occurrence count field
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that can be used to count a number of
occurrences of the branch condition.
See also secondary branch.

probe A device to connect the
various instruments of the logic
analysis system to the target system.
There are many types of probes and
the one you should use depends on
the instrument and your data
requirements. As a verb, "to probe"
means to attach a probe to the target
system.

processor probe See emulation
probe.

range terms Logic analyzer
resources that represent ranges of
values to be found on labeled sets of
bits. For example, range terms could
identify a range of addresses to be
found on the address bus or a range
of data values to be found on the data
bus. In the trigger sequence, range
terms are considered to be true when
any value within the range occurs.

relative Denotes time period or
count of states between the current
state and the previous state.

remote display A remote display is
a display other than the one
connected to the product hardware.
Remote displays must be identified to
the network through an address

location.

remote session A remote session is
when you run the logic analyzer using
a display that is located away from
the product hardware.

right-click To right-click an item,
position the cursor over the item, and
then quickly press and release the
right mouse button.

sample A data sample is a portion of
a data set, sometimes just one point.
When an instrument samples the
target system, it is taking a single
measurement as part of its data
acquisition cycle.

Sampling Use the selections under
the logic analyzer Sampling tab to tell
the logic analyzer how you want to
make measurements, such as State
vs. Timing.

secondary branch The secondary
branch is indicated in the Trigger
sequence step dialog box as the Else
on selection. The destination of the
secondary branch can be specified as
any other active sequence state. See
also primary branch.

session A session begins when you
start a local session or remolte
sesston from the session manager,
and ends when you select Exit from
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the main window. Exiting a session
returns all tools to their initial
configurations.

skew Skew is the difference in
channel delays between
measurement channels. Typically,
skew between modules is caused by
differences in designs of
measurement channels, and
differences in characteristics of the
electronic components within those
channels. You should adjust
measurement modules to eliminate
as much skew as possible so that it
does not affect the accuracy of your
measurements.

state measurement In a state
measurement, the logic analyzer is
clocked by a signal from the system
under test. Each time the clock signal
becomes valid, the analyzer samples
data from the system under test.
Since the analyzer is clocked by the
system, state measurements are
synchronous with the test system.

store qualification Store
qualification is only available in a
state measurement, not timing
measurements. Store qualification
allows you to specify the type of
information (all samples, no samples,
or selected states) to be stored in
memory. Use store qualification to
prevent memory from being filled

with unwanted activity such as no-
ops or wait-loops. To set up store
qualification, use the While storing
field in a logic analyzer trigger
sequence dialog.

subnet mask A subnet mask blocks
out part of an IP address so that the
networking software can determine
whether the destination host is on a
local or remote network. It is usually
represented as decimal numbers
separated by periods; for example,
255.255.255.0. Ask your LAN
administrator if you need a the
subnet mask for your network.

symbols Symbols represent
patterns and ranges of values found
on labeled sets of bits. Two kinds of
symbols are available:

e (Object file symbols - Symbols
from your source code, and
symbols generated by your
compiler. Object file symbols may
represent global variables,
functions, labels, and source line
numbers.

e User-defined symbols - Symbols
you create.

Symbols can be used as pattern and
range terms for:

e Searches in the listing display.
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e Triggering in logic analyzers and
in the source correlation trigger
setup.

e (Qualifying data in the filter tool
and system performance analysis
tool set.

system administrator The system
administrator is a person who
manages your system, taking care of
such tasks as adding peripheral
devices, adding new users, and doing
system backup. In general, the
system administrator is the person
you go to with questions about
implementing your software.

target system The system under
test, which contains the
microprocessor you are probing.

terms Terms are variables that can
be used in trigger sequences. A term
can be a single value on a label or set
of labels, any value within a range of
values on a label or set of labels, or a
glitch or edge transition on bits
within a label or set of labels.

TIM A TIM (Target Interface
Module) makes connections between
the cable from the emulation module
or emulation probe and the cable to
the debug port on the system under
test.

timer terms Logic analyzer
resources that are used to measure
the time the trigger sequence
remains within one sequence step, or
a set of sequence steps. Timers can
be used to detect when a condition
lasts too long or not long enough.
They can be used to measure pulse
duration, or duration of a wait loop. A
single timer term can be used to
delay trigger until a period of time
after detection of a significant event.

time-correlated Time correlated
measurements are measurements
involving more than one instrument
in which all instruments have a
common time or trigger reference.

timing measurement In a timing
measurement, the logic analyzer
samples data at regular intervals
according to a clock signal internal to
the timing analyzer. Since the
analyzer is clocked by a signal that is
not related to the system under test,
timing measurements capture traces
of electrical activity over time. These
measurements are asynchronous
with the test system.

tools A toolis a stand-alone piece of
functionality. A tool can be an
instrument that acquires data, a
display for viewing data, or a post-
processing analysis helper. Tools are
represented as icons in the main

36



Glossary

window of the interface.

toolbox The Toolbox is located on
the left side of the main window. It is
used to display the available
hardware and software tools. As you
add new tools to your system, their
icons will appear in the Toolbox.

tool icon Tool icons that appear in
the workspace are representations of
the hardware and software tools
selected from the toolbox. If they are
placed directly over a current
measurement, the tools automatically
connect to that measurement. If they
are placed on an open area of the
main window, you must connect them
to a measurement using the mouse.

trace See acquisition.

trigger Trigger is an event that
occurs immediately after the
instrument recognizes a match
between the incoming data and the
trigger specification. Once trigger
occurs, the instrument completes its
acquisition, including any store
qualification that may be specified.

trigger sequence A trigger
sequence is a sequence of events that
you specify. The logic analyzer
compares this sequence with the
samples it is collecting to determine
when to trigger.

trigger specification A trigger
specification is a set of conditions
that must be true before the
instrument triggers.

workspace The workspace is the
large area under the message bar and
to the right of the toolbox. The
workspace is where you place the
different instrument, display, and
analysis tools. Once in the workspace,
the tool icons graphically represent a
complete picture of the
measurements.

zooming In the oscilloscope or
timing analyzer, to expand and
contract the waveform along the time
base by varying the value in the s/Div
field. This action allows you to select
specific portions of a particular
waveform in acquisition memory that
will be displayed on the screen. You
can view any portion of the waveform
record in acquisition memory.
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A
A to D, testing example, 12

B
base, numeric base, 17

C

cancel, 18

chart, choosing data to plot, 13

chart, zooming in on data, 9

comments on display printouts, 24,
25

D

demand driven data, 21

disable/enable run status window,
20

display window pops up when run
completes, 23

F

find a pattern, 11
finding patterns, using X-Y
readout, 14

G
group run, 18

I
independent run, 18

L

label color, change, 8
loading chart configuration, 16

M
measurement, run options, 18

N
numeric base, setting, 17

(o)
options, run, 18

P

plot type, change, 8
plot, choosing data to plot, 13
printing the Chart window, 15

R

repetitive, 18

repetitive data display, 21
run, 18

run options, 20

run status, checking, 20

run status, disable window, 20

S

saving chart configurations, 16
scaling the chart axes, 9
scaling, return to full view, 9
scaling, undo last zoom, 10
single, 18

status, 20

stop, 18

T

tabs, turning on or off in display
window, 24

U
undo chart zoom, 10

Z
zooming in on chart data, 9
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